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1.0 Introduction

Arc Hydro is a data model, toolset, and workflows developed over the years to support specific
GIS implementations in water resources. The initial implementation of Arc Hydro was in 2002
with the data model, Arc Hydro book published by Esri Press, and initial set of about 30 tools.

Since then, Arc Hydro has been used in many projects and in the process new tools and
workflows have been developed. Arc Hydro tools now number in the 300s and continue to be
expanded based on work on specific implementations. Bulk of the Arc Hydro tools are
developed within ArcMap environment.

Arc Hydro tools are being transitioned to ArcGIS Pro (Pro) platform and portion of the tools are
fully operational in Pro.

Arc Hydro document “Arc Hydro: Project Development Best Practices” captures what works
well when implementing Arc Hydro projects and is required reading before continuing with
this document.

Pro has a default way in which it organizes data and project folders. This structure can be
leveraged to support Arc Hydro (AH) best practice for data and folder organization (section 4.2
in the “Arc Hydro: Project Development Best Practices” document). Remember that one of the
key elements of successful Arc Hydro implementation is use of data (both raster and vector) in a
consistent and appropriate spatial reference and organized in the same project database.

This document describes different alternatives for Arc Hydro in Pro new project startup through
a series of examples. Note that these are not the only ways to do it, so feel free to experiment

and come up with an approach that works the best for you.
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2.0 Arc Hydro Pro Project Startup Alternatives

This document describes different alternatives for Arc Hydro in Pro new project startup. To
demonstrate the alternatives, several projects will be initiated, and results examined. The
following folder is used for presentation of alternatives
(“C:\CurrWork\ArcHydro\Tests\ProStartup’’) and all alternatives will be stored within it.

2.1 No initial data when starting the project

This is the alternative where no initial data for Arc Hydro processing have been organized yet.
1. Start Pro and select new “Map” template.

2. Specify name of the new project and folder in which to create it. Keep “Create a new
folder for this project” checkbox checked. The specified project name should follow Arc
Hydro rules for project naming (short, no space, no special characters, ...). In this case,
we are naming the project “BaseAHProject” and placing it into
“C:\CurrWork\ArcHydro\Tests\ProStartup” parent folder.

Create a New Project X
MName BaseAHProject

Location | CACurrWork\ArcHydro\Tests\ProStartup

Create a new folder for this project

Ok Cancel

3. Click on OK to generate the project.

The following standard Pro project structure is created:
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&« w » This PC » 0&Disk (C:) » CurWork » ArcHydro » Tests » ProStartup » BaseAHProject »

e

Mame Date modified Type Size
BaseAHProject.gdb 8/6/20199:32 AM File folder
Importlog 8/6/2019 9:38 AM File folder
Index 8/6/2019 3:33 AM File folder
BaseAHProject.aprx 8/6/20199:38 AM ArcGl5 Project File 11 KE
) BaseAHProject.thx 8/6/20199:38 AM ArcGls Toolbox 4 KB

This is very similar to regular Arc Hydro recommended structure. Note that while the project
geodatabase is created, it does not have a feature dataset with particular spatial reference defined.
The following steps should be performed to bring the initial Pro structure consistent with
recommended AH project structure:

4. Create folder “Layers” within the Pro project folder
(“C:\CurrWork\ArcHydro\Tests\ProStartup\Base AHProject\Layers”). This folder is to be
used to store all raster data for the project (if any).

5. Create feature dataset called “Layers” in the project geodatabase
(“BaseAHProject.gdb\Layers”). Make sure you specify proper spatial reference when
creating the feature dataset — needs to match the spatial reference of any rasters that will
be used in the analyses.

6. “Copy” any raster and/or vector data into the “Layers” folder/feature dataset. Make sure
you apply proper spatial reference transformation if needed (vector data will be
automatically transformed as they are copied/imported into the feature dataset, but you
have to pay special attention to the raster data).

a. In this example, a raster “filsmc” is copied into the “Layers” folder and
“HydroEdge” feature class is imported into the “Layers” feature dataset.

The final Catalog structure after these steps looks like recommended Arc Hydro (10.x) project
structure:
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4 ol Folders

4 g, BaseAHProject

Importlog
P Layers
¢ B filsmc
4 & BaseAHProject.gdb
4 fp Layers

[~ HydroEdge

! BaseAHProject.thx

Note that default Pro startup will also create an empty toolbox that can be used for any locally
developed (project specific) tools.

2.2 Starting the project with Arc Hydro doing some configuration

Some Arc Hydro tools generate required data structures (e.g. geodatabase) if one is not present.
This use case presents a workflow that can be followed when it is known that AH tools will
create necessary geodatabase data structures. The example here uses AH terrain processing
steps. The tools that generate vector data from the rasters expect that a target geodatabase exists
and if it does not, they will create one.

The starting point for this scenario is an existing folder structure with raster data that will be used
in the AH tools that will generate required vector data structures (so initially raster data do exist,
but vector data do not). The existing folder is called
“C:\CurrWork\ArcHydro\Tests\ProStartup\StarterAHProject”, it has subfolder “Layers” with
rasters to be used in the analyses in it. A Catalog view looks like:

4 Starter&HProject
4 Layers
b B catddk

b BB filsmc
Once this structure is in place:
1. Start Pro and select new “Map” template.

2. Specify name of the new project and folder in which to create it. Keep “Create a new
folder for this project” checkbox unchecked. The specified project name should match
the name of the folder in which the project will be saved. In this case, we are naming the
project “StarterAHProject” and placing it into
“C:\CurrWork\ArcHydro\Tests\ProStartup\StarterAHProject” folder.
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Create a New Project X

MName StarterAHProj EI:t|

Location | CACurrWork\ArcHydro\Tests\ProStarg

[ ] Create a new folder for this project

OK Cancel
3. Click on OK to generate the project.
The following standard Pro project structure is created:
« v 4 » ThisPC » 0QS5Disk (C) » CurfWork » ArcHydro » Tests » ProStartup » StarterAHProject
Mame Date modified Type Size
ImportLog 3/6/2019 12:05 PM File folder
Index 8/6/201912:03 PM  File folder
Layers 8/6/201911:10 AM  File folder
StarterAHProject.gdb 2/6/201912:05 PM File folder
= StarterAHProject.aprx 3/6/2019 12:05 PM ArcGlS Project File 12 KB
@ StarterAHProject.thx 2/6/201912:05 PM ArcilS Toolbox 4 KB

Note that while the project geodatabase is created, it does not have a feature dataset with
particular spatial reference defined. The following steps should be performed to bring the initial
Pro structure consistent with recommended AH project structure:

4. Add to the map layers that will be used in the processing. In this case we will add raster
“cat40k” from the ”Layers” folder (which is now conveniently in the “Folders” project
structure in Pro.

5. Open Arc Hydro tool that generates an output feature class. In this example the
“Catchment Polygon Processing” tool.

a. Once the user interface for the tool opens and you select the input layer(s), the
default output will be populated. Inspect the location of the output layer. In this
case, the output will be pointing to a geodatabase that does exist, but feature
dataset that does not (that is OK).
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Geoprocessing

© Catchment Polygon Processing

Parameters Environments

Input Catchrent Raster
catdlk
(i) Output Catchment Feature Cla
C:Etchment

ChCurrWork\ArcHydro\ Tests\ProStartup’ StarterAHProject
YStarterAHProject.gdb' Layers\ Catchment

6. Run the tool.

7. Inspect the geodatabase.

a. Feature dataset was created, and the tool’s output feature class was stored in it.

b. The spatial reference of the feature dataset matches the spatial reference of the
input raster used in the function.

The final Catalog structure after these steps looks like recommended Arc Hydro (10.x) project

structure:

o Folders
4[5, StarterAHProject

4 ImportLog

4 Layers
b B catdk
v B filsme

4 3 StarterAHProject.gdb
4 [ Layers

Catchment
APUNIQUEID
b StarterAHProject.thy
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2.3 Leveraging an existing Arc Hydro dataset

Often, already processed AH data will be available as a starting point for a Pro project (specially
as you transition from 10.x platform to Pro). This use case examines situation where only data
are available, but an ArcMap project is not. A typical AH data structure might look like the one
below. In the example “AHFullData” folder contains the “Layers” folder with all the rasters and
“AHFullData.gdb” with vector and tabular AH data.

= £ AHFullData
= £ Layers
% B catdDk
+ B fac
+ B fdr
7 B filsmc
+ B stra0k
%) [ strink40k
= |3 AHFullData.gdb
= Hp Layers
[E) AdjointCatchmentdk
[E) Catchment40k
(=) DrainageLined0k
("] DrainagePoint40k
APUNIQUEID
Catchmentd0k_F5
DrainageLinedk_FS

When creating a new Pro project, there are several elements that get created (default folder,
geodatabase, and toolbox). By default, they have the same name as the Pro project name. Since
we want to create a Pro project with the same name as an existing geodatabase, this will cause a
conflict, so we have to apply a workaround. Two approaches are presented.

1. Existing geodatabase rename approach.

2. Repointing defaults approach.

2.3.1 Existing geodatabase rename approach
To mobilize this data structure in Pro use the following procedure:

1. Before starting Pro, open target project folder in file manager (e.g.
“C:\CurrWork\ArcHydro\Tests\ProStartup\AHFullData’’) and rename the existing
geodatabase to something else (e.g. “AHFullData.gdb” to “AHFullDatal11.gdb”).

2. Start Pro and select new “Map” template.
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3. Specify name of the new project and folder in which to create it. Keep “Create a new
folder for this project” checkbox unchecked. The specified project name should match
the name of the folder in which the project will be saved. In this case, we are naming the
project “AHFullData” and placing it into
“C:\CurrWork\ArcHydro\Tests\ProStartup\AHFullData” folder.

Create a Mew Project X
Location C'xCurr'-.-‘-.-':rk".,-f-.'cl-}'dr:u"-.Tests‘uPr::uStart ~

[] Create a new folder for this project

QK Cancel

4. Click on OK to generate the project.
5. Close the Pro project.

6. Open the file manager and inspect the project folder. Several new folders and files are
present.

a. Delete the NEWLY created project geodatabase (e.g. “AHFullData.gdb).

b. Rename the existing (o0ld) geodatabase to what it was originally (e.g.
“AHFullDatal11.gdb” to “AHFullData.gdb”).

7. Open Pro and the just saved project. Inspect the data structure. Everything should be
pointing to the right sources.
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4 ol Folders
4 Wy, AHFullData
Importlog
F Layers
v B catd0k
+ B fac
v B fdr
v B filsmc
v B strdOk
v B strink40k
4 & AHFullData.gdb
4 Layers
AdjointCatchment40k
Catchment40k
DrainageLined0k
(-] DrainagePointd0k
APUNIQUEID
Catchment40k_FS
DrainageLinedDk_F5
! AHFullData.thx

2.3.2 Repointing defaults approach

This approach is a bit more “Pro-ish” and does not require renaming geodatabase at file manager
level, but it involves more steps.

1. Start Pro and select new “Map” template.

2. Specify name of the new project and folder in which to create it. Keep “Create a new
folder for this project” checkbox unchecked. The specified project name can be
anything EXCEPT the name of the folder in which the project will be saved. In this case,
we are naming the project “MyProject” and placing it into
“C:\CurrWork\ArcHydro\Tests\ProStartup\AHFullDataA2” folder.
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Create a New Project X

MName MyProject

Locati CACurrWorkh\ArcHydro\Tests\ProStartup\AHFullDataA2

|:| Create a new

QK Cancel

3. Click on “Project = Save As” (main Pro tab).

4. Specify name of the new project and folder in which to create it. The specified project
name should match the name of the folder in which the project will be saved. In this
case, we are naming the project “AHFullDataA2” and placing it into
“C:\CurrWork\ArcHydro\Tests\ProStartup\ AHFullDataA2” folder.

Save Project As
'&:' I:‘ CACurrWorkhArcHydrohTests\ProStartup\AHFull DataA2 - §| Search Home 2
Organize * MNew ltem ~ T B\
4 | =) Project me Type Cate
o Folders Importlog Falder 8/6/2019 5:32 PM
4 [0 Computer Bl Index Folder 8/6/2019 5:31 PM
Desktop Layers Folder 8/6/2019 5:05 PM
Documents E MyProject.aprs ArcGIS Pro Project 8/6/2019 5:32 PM
Downloads
C
Name | AHFullDataA2.aprx | Prajects (APRX)
| Save | | Cancel

5. Copy the default toolbox to match the name of the project and put it into the project
folder (e.g. “MyProject.tbx” as “AHFullDataA2.tbx”).

6. Add that toolbox to Pro’s project “Toolboxes”.

7. Pro’s catalog should look like:
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o Maps
4 @ Toolboxes
b Eg MyProject.thx
! AHFullDataA2 thx
=l Databases
i Styles
4 el Folders
4 gy AHFullDatahl
ImportLog
Index
Layers
B AHFullDataA2.gdb
= MyProject.gdb
[ AHFullDatab th
! MyProject.thx

8. Click on “Project — Options -> Current Settings” (main Pro tab).

9. Repoint the “Default geodatabase” and “Default toolbox™ to appropriate entities (e.g.
“AHFullDataA2.gdb” and “AHFullDataA2.tbx”’). The form should look like:
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Options

Project . .
Change settings for the current project.
Current Settings
Units Mame
Tasks AHFullDataA2
Application Location
General

Map and 5cene

Navigation ;
ChCurrWork\ArcHydro\ Tests\ProStartupt AHFullDataA2 3

Selection

Editing Default geodatabase

Geoprocessing

Share and Download

CHhCurrWorl\ArcHydro\ Tests\ProStartuphAHFullDataAZ\AHFullDataA2.aprx

Harme folder

CACurrWork\ArcHydro\ Tests\ProStartuphAHFullDataAZ\AHFullDataA2.gdb

Default toolbox

Raster and Imagery

Ch\CurrWork\ArcHydro'\ Tests\ProStartup\AHFullDataA2\ AHFullDataA2.thx
Display

Layout

CAD

Metadata

Indexing

Location Referencing

Proofing Learn more about changing a project's settings

QK | | Cancel

10. Press “OK” to apply changes and “Save” to save the project.
11. From the catalog view, inspect changes.

12. Delete all references to “MyProject” (aprx, tbx, gdb)

2.4 Leveraging an existing Arc Hydro dataset and 10.x project

Often, already processed AH data and 10.x ArcMap project (mxd) will be available as a starting
point in a Pro project (as you transition from 10.x platform to Pro). A typical AH data structure
might look like the one below. In the example “AHFullProject” folder contains the “Layers”
folder with all the rasters, “AHFullProject.gdb” with vector and tabular AH data, and
“AHFullProject.mxd” ArcMap project.
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= EJ AHFullProject
= B3 Layers
B catdk
# fac
i fdr
@ filsmc
B ctraik
B8 strink40k
=l L3 AHFullProject.gdb
= 27 Layers
(&) AdjointCatchment40k
[E] Catchment40k
(= DrainagelinedOk
("] DrainagePoint40k
APUNIQUEID
Catchmentd0k_FS
DrainagelinedDk_FS
Q| AHFullProject.msd

1. Start Pro and select new “Map” template.

2. Specify name of the new project and folder in which to create it. Keep “Create a new
folder for this project” checkbox unchecked. The specified project name can be
anything EXCEPT the name of the folder in which the project will be saved. In this case,
we are naming the project “MyProject” and placing it into
“C:\CurrWork\ArcHydro\Tests\ProStartup\AHFullProject” folder.

Create a New Project X

MName MyProject

Lcucatic:r(! CACurrWork\ArcHydro\Tests\ProStartup\AHFullProject ? ~

[ | Create a new folder Tor this project

O Cancel

3. Click on “Insert — Import Map” (main Pro tab).

4. Navigate to the existing ArcMap mxd to import (in this case
“C:\CurrWork\ArcHydro\Tests\ProStartup\AHFullProject\AHFullProject.mxd”) and
press “OK”.
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Import

'i‘B' I:‘ » Project » Folders » AHFullProject » - §|

Search Project

Organize ~ MNew ltem ~
i
4 [ Project Name Type

v Folders | Layers Folder

Cate
8/7/2019 12:46 AM

¢ e

4 & Portal | @ AHFullProject.mxd Map Document

8/6/2019 1:28 PM

* My Content

Groups

All Portal

¢ Living Atlas

4 [{3 Computer

Desktop L d

B D® R

MName | AHFullProject.mxd | Default

[] Reuse existing maps when importing layouts

5. Click on “Project = Save As” (main Pro tab).

6. Specify name of the new project and folder in which to create it. The specified project

name should match the name of the folder in which the project will be saved. In this

case, we are naming the project “AHFullProject” and placing it into
“C:\CurrWork\ArcHydro\Tests\ProStartup\ AHFullProject” folder.

Save Project As X
'i‘B' I:‘ » Computer » C\ » CurrWork » ArcHydro » Tests » ProStartup » AHFullProject » - §|
Organize * New ltem ~ T E
A| [ Project MName Type Date
1 Folders Importlog Falder 8/7/2019 12:55 AM
4 |:|:| Computer Index Folder 8/7/2019 12:52 AM
Desktop Folder 8/7/2019 12:55 AM
Documents ArcGIS Pro Project 8/7/2019 12:52 AM
Downloads
MName AH:uIIP’ojecﬂ | Projects (APRX)
| Save | | Cancel |
7. Copy the default toolbox to match the name of the project and put it into the project
folder (e.g. “MyProject.tbx” as “AHFullProject.tbx”).
8. Add that toolbox to Pro’s project “Toolboxes”.
9. Pro’s catalog should look like:
8/2019
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o Maps
4 [ Toolboxes
b Eg MyProject.thx
f AHFullProject.thx
4 5l Databases
l‘_:yi. MyProject.gdb
= Layouts
iz otyles
4w Folders
4 gy AHFUllProject
Importlog
Index
Layers
B AHFullProject.gdb
= MyProject.gdb
I MyProject.thx
AHFullProject.thx
&l AHFullProject.mxd

10. Click on “Project — Options -> Current Settings” (main Pro tab).

11. Repoint the “Default geodatabase” and “Default toolbox™ to appropriate entities (e.g.
“AHFullProject.gdb” and “AHFullProject.tbx”). The form should look like:
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Options X

Project = . .
Change settings for the current project.
Current Settings
Units Name
Tasks AHFullProject
Application Lecation
General CACurrWork\ArcHydro\ Tests\ProStartup\ AHFullProject\ AHFullProject.aprx

Map and Scene Home folder

MNavigation - .
CACurrWork\ArcHydro\ Tests\ProStartup\AHFullProject
Selection

Editing Default geodatabase

Geoprocessing C:A\CurrWork\ArcHydroh Tests\ProStartup\ AHFullProject\AHFullProject.gdb

Share and Download Default toolbox

Raster and Imagery ChCurrWork\ArcHydro\ Tests\ProStartuphAHFullProject\AHFullProject.thx ]
Display

Layout

CAD

Metadata

Indexing

Location Referencing

Procfing Learn more about changing a project's settings

oK | | Cancel

12. Press “OK” to apply changes and “Save” to save the project.
13. From the catalog view, inspect changes.

14. Delete all references to “MyProject” (tbx, gdb, aprx — might have to be deleted from file
manager).
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